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1 Installation 

It's recommended to uninstall previous KNX Eno Tool versions before installing the new one. Run 

the setup installer Setup_KNXEnoTool_22.0.0.exe and follow all the instructions in the appearing 

dialog boxes. 

2 Requirement 

The KNX Eno Tool can be installed on Windows 7, Windows 8, Windows 8.1 and Windows 10. 

3 General 

The KNX Eno Tool is a KNX EnOcean link configuration and bus monitor tool for the Weinzierl 

KNX ENO 626, 63x product line. It can be used to configure links between different EnOcean 

devices and the EnOcean Gateway. 

The teach-in process of sensors and actuators can be completely remote-controlled via the 

software. The existing configuration of a Gateway can be read out, changed on the PC, archived 

and transferred back to the same or another gateway. 

In addition, a bus monitor is included to display EnOcean telegrams via the KNX bus. 

 

KNX Eno Tool: Main Window 
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The basic configuration of a device has to be done in the ETS. There you can configure 

the general settings, like the device name or add and configure the channels. The 

KNX Eno Tool reads this configuration and allows the user to use different helpful 

functionalities, like adding or removing links. 

The following devices are supported: 

 

There is a separate tool for the KNX ENO 620 and KNX ENO 622 devices, which can 

be downloaded from our website. 

4 The Main Menu 

The main menu provides all important functions of the KNX Eno Tool. In addition to basic features 

like creating a new configuration or opening an existing configuration, here are also the elements 

for searching and opening a KNX interface. 

KNX ENO 630 

 

KNX ENO 632 

 

KNX ENO 634 

 

KNX ENO 626 secure 

 

KNX ENO 636 secure 
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KNX Eno Tool: Main Menu 

4.1 File 

It is possible to open a new, empty configuration via "New" (Ctrl+N). This will be opened in a new 

tab inside the configuration window. 

Using the menu item "Open" (Ctrl+O), already created and saved configurations can be opened in 

order to subsequently change them again or to load them into another device. 

When selecting the menu item "Save" (Ctrl+S), the currently selected configuration can be saved. 

If this is the first save operation for this configuration file, a new window opens in which the storage 

location and a file name must be specified. At each subsequent process, the save is made directly. 

With "Save as" (Ctrl+Alt+S) an already saved configuration can be saved under a new name. This 

is useful, for example, for changes where the initial configuration should not be lost. 

 

The mentioned functions can also be selected via the quick selection icons directly 

under the menu item "File". 

There is also the possibility to open "Recent files" and "Exit" (Alt+F4) the application. 

 

KNX Eno Tool: File Menu 

4.2 Settings 

In the "Settings" menu, the language of the KNX Eno Tool can be selected via "Language". 

Available languages are currently German and English. 

4.3 Window 

The "Window" menu contains all functions concerning the configuration window. Selecting "Close" 

will close the currently selected configuration. When selecting "Close All" all open configurations 

will be closed. 

 

If an attempt is made to close a configuration in which there are still unsaved changes, 

a warning window is displayed. It is possible to save or discard the changes. 
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The functions "Cascade", "Tile Automatically", "Tile Horizontally" and "Tile Vertically" allow 

arranging the opened configurations differently. When selecting one of these functions the 

configuration windows are released and can be manually arranged within the configuration 

window. 

With "Next" and "Previous" you can jump between the individual configuration windows - either to 

the next one - or to the previous one. The order is determined by the order opened in the 

KNX Eno Tool, with the starting point being the currently active window. 

 

KNX Eno Tool: Window Menu 

 

At the bottom of the "Window" menu, all currently open configuration files are displayed 

in order and the active window is marked with a check mark. 

4.4 ?-Help 

In the "Help" menu, the user manual can be opened via "Help". "Info" opens a small information 

window that contains a short description of the KNX Eno Tool as well as the version designation. 

5 Searching and Opening KNX Interfaces 

In order to read and write configurations, a connection to the KNX bus via a KNX interface is 

required. To find available KNX interfaces, a search process is already carried out at the start of 

the KNX Eno Tool. 

KNX interfaces added later can be found at any time with a manually started search process, by 

just clicking on the "Search" button. 

To open a KNX Interface, the connection type has to be selected first. For KNX IP Tunneling, 

choose "knx.ip.tunneling". KNX USB interfaces can be found under "knx.usb". The found interfaces 

are displayed in the adjacent DropDown Box with corresponding information, such as IP address 

or individual address (depending on selection and configuration). 
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For KNX IP Tunneling Interfaces there is an additional "Custom tunneling port”. With this a 

KNX IP Interface can be selected with its IP address and port (default KNX Port is 3671). This port 

always uses the NAT mode, to be able to use interfaces over the internet. 

 

KNX Eno Tool: ToolBar Custom tunneling port 

Once an interface has been selected, a connection can be established, by clicking on the 

"Connect" button. To close a connection to an interface, just click on the "Disconnect" button. 

5.1 Change Interface Settings 

Selecting "Configuration" opens a window with the interface settings. In this window the settings of 

the current interface can be read and the Individual Address of the interface can be edited. 

 

KNX Eno Tool: Interface Settings 

 

The new Individual Address has to be selected according to the topology of the KNX 

Installation. 

5.2 KNXnet/IP security 

For tunneling connections, the user to be used and it’s password can also be specified in order to 

establish a secure tunneling connection. If a password is specified, an attempt is always made to 

establish a secure tunnel connection. 
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KNX Eno Tool: ToolBar Tunneling Port with activated KNXnet/IP security 

By default, the ETS generates passwords for all users, but these can be adapted according to your 

own needs. 

 

User 1 is always the management connection, whose password can be found under 

Devices/Properties/IP/Commissioning Password. 

The Authentication Code is not mandatory, but increases the connection security. 
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Further, a user is assigned to each tunneling interface. The first tunnel of the interface can be used 

with user 2, the second with user 3 and so on. For this, the passwords are displayed under 

Devices/Properties/Settings/Password. 

6 The Configuration Window 

The configuration window is the main window of the KNX Eno Tool. Here the configurations of Eno 

devices can be read out, changed or transferred to a new device. 

It is divided into two areas. On the one hand the menu area in which an Eno device can be 

connected, additional options are provided and the bus monitor can be opened. On the other hand 

the configuration table which displays the read configuration data. 
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KNX Eno Tool: Configuration Window 

6.1 The Menu Area 

In the menu area it is possible to enter the individual address of the Eno Gateway. Alternatively, an 

Eno Gateway can also be recognized in programming mode with the "Read Learn" button and its 

address can be entered automatically. Please note that only one Eno Gateway is in programming 

mode. 

 

KNX Eno Tool: Device Address in the Configuration Window 

The "Device Name" area displays the device name entered in the ETS configuration 

(KNX Eno 626, 636) or the device type (KNX Eno 630, 632, 634). 

To open a bus monitor in which all transmitted Eno telegrams are displayed, click on the button 

"Bus Monitor View". 

In the menu area "Remote Device Session" you can manage the device. Via the "Connect" button 

a connection to the device can be established. With the "Close" button it can be closed again. 

Using the "Write" button, link ID's that have been changed in the configuration table can be written 

directly into the device. Possible changes to the links or security data will activate the "Refresh" 

button, which will allow the links and security data to be re-read. 

 

When executing the link write process, the device is restarted! 
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6.1.1 The Link Configuration Window 

Behind the "Interactive Remote Control Session" button hides the link configuration window. Here 

new links can be added or removed. To add a new link, just click on the “Add Link” button to 

activate the “Learn mode”. The ID of the next device which sends a Teach-In telegram is added to 

the links. You can also delete all links. In addition, it is possible to delete individual links via "Delete 

Link" by receiving a teach-in telegram or to delete all links with "Delete all links". 

With the arrow buttons or the drop-down menu you can switch between the configured channels. 

 

KNX Eno Tool: Link Configuration Window 

6.1.2 Manage the Base ID 

With a click on the button "Manage the Base ID" an administration window opens in which the 

Eno Base ID of the connected Eno device can be changed. 

The new Base ID can easily be entered into the appropriate fields and then will be written into the 

device by clicking on the "Set ID" button. 
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KNX Eno Tool: Base ID Window 

 

The number of remaining cycles indicates how often the Eno Base ID can still be 

written. If the value is 0, the ID cannot be changed anymore. 

6.2 The Configuration Table 

The configuration table shows the read configuration of the connected Eno device. Information of 

the particular channel is displayed, sorted by channel number. 

 

KNX Eno Tool: Configuration Table in the Configuration Window 

The Configuration Table contains following Information: 

Label Description 

Channel number Number of the Channel 

Secure Channels marked with a lock have been configured as secured in the ETS 

Function The device connected to the channel is displayed visually 

Device Description of the device (sensor or actuator) 

EEP EnOcean Equipment Profile of the device connected to the channel 

Title The channel designation text configured in the ETS 

ID The device ID's connected to this channel 
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The ID's can be edited directly with a double click in the respective cell. After changing 

an ID, it is displayed in red to signalize a change. The "Write" button from the menu 

area can be used to transfer the changes to the device. 

6.2.1 Security Data 

Secured devices have additional parameters that can be expanded and collapsed with the arrow 

on the left side. These can be edited by double-clicking on them, the changes are indicated by red 

text, just like links. 

 

Normally, these parameters must not be edited manually, otherwise the secure Eno 

device will no longer be able to communicate with the Eno gateway. 

For sensors, the following device security data of the connected Eno device is displayed: 

For actuators, the following channel security data of the Eno Gateway channel is displayed: 

7 The BusMonitor 

The BusMonitor displays information of sent and received telegrams. It can be opened via the 

"BusMonitor View" button in the menu area of the configuration window. The telegrams are 

numbered with time specification and displayed in tabular form. 

In addition to the sending direction (sending or receiving), there is also displayed the type of the 

telegram (Eno data, KNX, Eno Teach-In, Eno Teach-In (Sec)). 

In addition, the data (in the case of Eno data or KNX telegrams), the ID of the transmitter, as well 

as the EEP/RORG information and the connection quality (RSSI), are shown. 

For subsequent analysis of communication traffic, the BusMonitor list can also be saved using 

"Save" or "Save as...".  

If the content of the BusMonitor list is no longer necessary, it can be removed using the "Delete" 

button. Afterwards the BusMonitor is completely empty again. 

Parameter Description 

SLF Security level format 

RLC Rolling Code 

Key The key to decrypt the telegram 

Parameter Beschreibung 

RLC Rolling Code 

Key The key to decrypt the telegram 
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KNX Eno Tool: BusMonitor 

 

When analyzing the connection quality (RSSI), make sure that it is at least 2, otherwise 

the transmission is unreliable. There might be a loss of data due to other changing, 

external influences. 

 

"Data" of secure telegrams are not displayed decrypted. 

 

  



 

© 2022 WEINZIERL ENGINEERING GmbH Page 16/16 

 

 

 

 WEINZIERL ENGINEERING GmbH 

Achatz 3-4 

84508 Burgkirchen an der Alz 

GERMANY 

 Tel.: +49 8677 / 916 36 – 0 

E-Mail: info@weinzierl.de 

Web: www.weinzierl.de 

 

 2022-08-29 

 


	1  Installation
	2 Requirement
	3 General
	4 The Main Menu
	4.1 File
	4.2 Settings
	4.3 Window
	4.4 ?-Help

	5 Searching and Opening KNX Interfaces
	1.1
	5.1 Change Interface Settings
	5.2 KNXnet/IP security

	6 The Configuration Window
	6.1 The Menu Area
	6.1.1 The Link Configuration Window
	6.1.2 Manage the Base ID

	6.2 The Configuration Table
	6.2.1 Security Data


	7 The BusMonitor

